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ABSTRAKT 

Tato diplomová práce se zabývá rozpočtem hraného filmu v oblasti české kinematografie a 

počítačovým programem Movie Magic Budgeting, který se specializuje na práci s filmovým 

rozpočtem. V práci jsou představeny jednotlivé funkce a nástroje programu a jejich užití 

v českých podmínkách. Práce obsahuje vymezení struktury a fáze rozpočtu. Součástí je také 

porovnání forem rozpočtu, které se objevují v oblasti české kinematografie. Ve výzkumné 

části práce je zmapovaná míra užívání programu Movie Magic Budgeting napříč 

nezávislými produkčními společnostmi a producenty působící v oblasti českého hraného 

filmu. 

 

Klíčová slova: rozpočet, rozpočtování, hraný film, produkce, Movie Magic Budgeting 

 

 

 

ABSTRACT 

This thesis focuses on a feature film budget within the sphere of Czech cinematography and 

the Movie Magic Budgeting computer programme specialising in film budgeting. The work 

introduces individual functions and tools of the programme in addition to their utilisation 

within Czech settings. Furthermore, the budget structure and stages are defined in the work. 

It also compares forms of budget appearing in Czech cinematography. The research part of 

the work surveys the extent of usage of the Movie Magic Budgeting programme across 

independent production companies and producers working in the Czech feature film 

environment. 
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ÚVOD 

„V přípravné fázi audiovizuální produkce se vyskytuje několik výstupů, které přímo 

ovlivňují realizaci celého díla. Tím nejdůležitějším je jednoznačně literární scénář, ze 

kterého dále vychází technický scénář, natáčecí plán a rozpočet.“1 

Rozpočet prochází skrze všechny fáze výroby audiovizuálního díla (dále AV díla) a je 

nástrojem sloužící k alokaci finančních prostředků. Definuje celkový rozsah AV díla a jeho 

obsahem jsou všechny položky nezbytné k vývoji, přípravě, samotné výrobě, dokončení a 

distribuci AV díla. Udává celkovou finanční náročnost AV díla a určuje distribuci finančních 

prostředků producenta.  

Umění sestavení rozpočtu a práce s ním je jedním z nejdůležitějších schopností producenta 

v nezávislé produkci. Limity, které nezávislou produkci provází (tj. nedostatek financí), jsou 

pouze příležitostí pro hledání kreativního řešení. Věděním, jak sestavit a porozumět 

rozpočtu, získáte schopnost řešit problémy, kterým budete při výrobě čelit.2 

Program Movie Magic Budgeting je počítačový software, který používají nezávislí 

producenti i velká filmová studia po celém světě k sestavení rozpočtu a k práci s ním. 

Součástí této práce je i průzkum využití tohoto programu mezi producenty českého hraného 

filmu.   

Tato práce se zabývá možnostmi využití programu Movie Magic Budgeting při práci se 

standardním rozpočtem českého hraného filmu. Cílem této práce je přiblížit program lidem 

pohybující se ve filmové produkci a pomocí návodu na jeho užívání popsat možnosti i úskalí 

spojené s konvenčním sestavením a správou rozpočtu AV díla.  

V této práci je také předloženo srovnání možností, které nabízí program Movie Magic 

Budgeting s jinými formami rozpočtu, které se v oblasti výroby českého hraného filmu 

používají. 

 
1 MEDEK, Jakub, 2017. Plánování natáčení v programu Movie Magic Scheduling. Zlín. Bakalářská práce. 
Univerzita Tomáše Bati ve Zlíně. Fakulta multimediálních komunikací. Vedoucí práce Mgr. Viktor Mayer, s. 
10. 
2 RYAN, Maureen A., 2010. Producer to producer: a step-by-step guide to low-budget independent film 
producing. Studio City, CA: Michael Wiese Productions. ISBN 978-1932907759, s. 89. 
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1 ROZPOČET 

Rozpočet je seznam všech výdajů týkající se výroby AV díla a s tím spojených příprav, 

natáčení, dokončovacích prací i jeho distribuce. Slouží k ekonomické orientaci 

v jednotlivých fázích výroby. Definuje a zároveň vizualizuje celkový rozsah projektu a 

sumarizuje veškeré položky s ním spojené jako počet lokací, herců, techniky, rekvizit, 

kostýmů, speciálních efektů, členů štábu atd. Rozpočet pomáhá konceptualizovat celý 

projekt a nastavuje, co bude stát kolik peněz. Jedině s takovým nástrojem lze vytvořit 

představu o tom, jakým způsobem se bude daný projekt realizovat. 

V knize Independent Filmmaker’s Manual autor píše, že sestavením rozpočtu zjistíte, zda 

můžete vyrobit film, který chcete, za peníze, které máte.  Rozpočet vám řekne, kolik váš film 

bude stát peněz a pomůže vám sledovat všechny potřeby s filmem spjaté. Aktualizováním 

rozpočtu zjistíte, kolik peněz jste již utratili a kolik jich máte stále k dispozici.3 

Vznik rozpočtu je úzce spjat s literárním scénářem a natáčecím plánem. „Natáčecí plán a 

rozpočet jdou ruku v ruce. Často nemáte moc na výběr. Když máte určenou částku k natočení 

filmu, musíte vytvořit takový natáčecí plán, který se hodí vašemu rozpočtu a zároveň váš 

rozpočet přizpůsobujete natáčecímu plánu.“4 Vzájemně musí korespondovat a jakákoliv 

změna v natáčecím plánu se musí projevit i v rozpočtu a naopak. Samotný vznik obou 

dokumentů musí vznikat ve vzájemném povědomí. „Bylo by hezké, kdyby šlo naplánovat 

celý film a pak se podívat, kolik peněz na něj potřebujete, ale filmaři většinou mají pouze 

takové prostředky, že se jejich filmy musí přizpůsobovat rozpočtu a nikoliv obráceně. Je to 

jako se snažit zabalit příliš mnoho oblečení do malého kufru – tlačíte na něj všemi silami a 

doufáte, že se vám jej podaří zavřít. Musíte se obejít bez čehokoliv, co se do kufru nevejde.“5 

Je nezbytné rozpočet v průběhu všech fází výroby stále aktualizovat a reagovat na nové 

události a nečekané výdaje, které se v průběhu výroby AV díla objevují. „Rozpočet je jako 

pracovní návod, není však vytesaný do kamene. Skutečně utracená suma za jednotlivé 

položky se většinou oproti původním číslům v rozpočtu liší. Rozpočet proto musí být 

dostatečně flexibilní, aby obsáhl i všechny nečekané výdaje.“6 

 
3 WURMFELD, Eden H., Nicole Shay LALOGGIA a Nicole Shay LALOGGIA, 2004. IFP/Los Angeles 
independent filmmaker's manual. 2nd ed. Waltham, MA: Focal Press. ISBN 0-240-80585-2, s. 75. 
4 STOLLER, Bryan Michael, c2009. Filmmaking for dummies. 2nd ed. Hoboken, NJ: Wiley Pub. ISBN 
9780470386941, s. 49. 
5 Tamtéž, s. 50. 
6 WURMFELD, cit. 10, s. 75. 
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V určité chvíli sestavování rozpočtu lze dosáhnout jeho finální podoby, která udává 

celkovou sumu potřebnou k vytvoření AV díla. V anglickém jazyce se pro tuto fázi používá 

výraz locked budget neboli zamčený rozpočet. Ve studiovém systému je vyžadováno tuto 

verzi rozpočtu podepsat výkonnými producenty, kteří se zavazují k jeho nepřekročení.  

1.1 Struktura 

Existuje mnoho způsobů, jakými lze rozpočet vizualizovat. V praxi pro to není žádný obecný 

standard. Každá produkční společnost či studio má svou vlastní šablonu, kterou používá. 

Obecně platí, že seznam výdajů je zarovnán do řádků v tabulce s oddělenou sumou za 

jednotlivé položky v samostatném sloupci pod sebou tak, aby šlo sečíst celkovou sumu za 

všechny položky. 

1.1.1 Above The Line 

Existují určité konvence, podle kterých se řídí sestavení rozpočtu hraného filmu. Jednou 

z nich je rozdělení rozpočtu do dvou hlavních částí - Above The Line neboli nad čarou a 

Below The Line neboli pod čarou. Mezi českými filmovými produkcemi se tento systém 

často nevyskytuje i přesto, že má toto rozdělení logické a praktické využití.  

Do části Above The Line se udávají hlavní kreativní náklady filmu jako scénář, režisér, 

producent a herecké obsazení. V této části rozpočtu je vyčíslena pomyslná tvář filmu, která 

bude snímek reprezentovat v propagačních materiálech filmu. „Náklady v části Above The 

Line startují celý proces. Idea zformovaná ve scénáři, producent, který řídí celý proces, 

režisér, který vizualizuje film, a herecké obsazení, které realizuje role. Tato čára (the Line) 

sice slouží k organizaci nákladů, ale není vryta v betonu. Jakákoliv položka z části pod čarou 

může být přesunuta do horní části, pokud je považována za hlavní faktor ve vývoji 

projektu“.7 

1.1.2 Below The Line 

Spodní část rozpočtu Below The Line je tvořena ostatními položkami, které se vyskytují 

v samotné výrobě hraného filmu jako štáb, lokace, rekvizity, technika, zázemí atd. Náklady 

objevující se v postprodukci jako jsou střih, vizuální efekty či hudba jsou také součástí 

Below The Line, ale v některých případech mohou mít další samostatnou kategorii. Stejně 

 
7 LANDRY, Paula, 2012. Scheduling and budgeting your film: a panic-free guide. Boston: Focal 
Press/Elsevier. ISBN 978-0-240-81664-7, s. 110. 
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tak náklady zařazené do sekce „ostatní“, ve které se objevují položky jako pojištění anebo 

náklady na publicistiku. 

1.1.3 Vrstvy 

Dalším pravidlem pro stavbu rozpočtu je rozdělení do vrstev. V programu Movie Magic 

Budgeting je orientace v rozpočtu založena na pohybu mezi těmito vrstvami. Díky tomu 

se z tohoto způsobu vrstvení stal světový standard. Nejdůležitější funkci má Topsheet, první 

vrstva (označovaná českými produkcemi jako „přední strana“, „rekapitulace položek“, nebo 

v případě rozpočtu pro Státní fond kinematografie „přehled hlavních kapitol rozpočtu“). Na 

přední straně je výčet všech kategorií rozpočtu a jejich celková suma. Zároveň se zde 

objevuje celkový součet všech kategorií neboli konečná výše rozpočtu. Tato přední strana 

slouží k rychlému přehledu o rozpočtu. V některých případech se na této straně objevují 

informace o produkční společnosti, samotném projektu, verzi rozpočtu a případně i o 

autorovi rozpočtu. Lze říci, že stejně jako synopse shrnuje celý scénář na jedné stránce, 

topsheet je shrnutím celého rozpočtu. Typicky tato strana zastupuje celý rozpočet v případě 

jednání se sponzory, investory apod., které zajímá sumarizace nákladů a nikoliv komplexní 

výčet všech položek v rozpočtu.  

Druhá vrstva se označuje Account Level a rozepisuje jednotlivé kategorie do podrobnějších 

položek a sekcí, například ucelených výdajů za konkrétní lidi, rentaly, oddělení apod. 

V českých podmínkách bývá tato úroveň často konečnou vrstvou, ve které se objevují i 

jednotlivé položky a jejich cena.   

V komplexnějších rozpočtech však bývá ještě třetí vrstva označovaná jako Detail, ve které 

jsou jednotlivé položky rozepsány ještě podrobněji. Typicky se tato úroveň používá u 

položek štábu, kde se rozkládá celkový výdaj za konkrétní lidi do položek za přípravu, 

dokončovací práce, přesčasy apod., anebo u rekvizit, u kterých se vypisují jednotlivé věci 

v daných položkách. V programu Movie Magic Budget se až v této vrstvě vkládají 

samostatná data s informacemi o ceně.  

V některých případech lze pokračovat ještě do čtvrté vrstvy, do které se zadává samostatný 

finanční rozklad jednotlivých položek, je-li to potřeba. Například když je potřeba do 

rozpočtu vložit soupis kompletní kamerové techniky.  

„Většinou je rozpočet rozložen přes několik stránek a tato několikavrstevná struktura 

funguje jako zoom na objektivu. Dovoluje pracovat v různých perspektivách vně a skrze 

rozpočet podle potřeby. Topsheet je jako establishový záběr (široký obraz), Account Level 
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je jako Medium Shot (kdo nebo co je zapojen) a Detail Level je jako Close Up (pro vkládání 

dat do kalkulace). Čtvrtý level pak slouží jako Extreme Close Up neboli velký detail.“8 

1.1.4 Account Codes 

Acount Codes neboli účetní kódy se používají pro ještě přehlednější členění položek 

v rozpočtu. Každá jednotlivá položka v druhé úrovni rozpočtu (Account Level) má přidělený 

svůj číselný kód, který je podřazený číslu dané kategorie z první úrovně (Topsheet). 

V programu Movie Magic Budgeting se již v dalších vrstvách kódy nepoužívají. Podle 

rozsahu rozpočtu se může používat čtyřmístný až šestimístní kód. První dvě čísla vždy 

označují kategorii a v některých případech se od ostatních čísel oddělují čárkou (10-000). 

Zbylá čísla jsou pak dosazeny k položkám, které přísluší patřičné kategorii (10-001, 10-002 

atd.).  

Pomocí účetních kódů lze v programu Movie Magic Budgeting vyhledávat konkrétní 

položky. V některých případech se tyto kódy dále používají během vyúčtování a auditu 

projektu.  

1.2 Aproximativní rozpočet 

V průběhu vzniku AV díla se rozpočet proměňuje společně s projektem. Celou dobu 

prochází vývojem a musí reagovat na nastalé události a nové informace. Nelze s určitostí 

rozdělit tento proces na ucelené fáze. Lze však vymezit rozpočet aproximativní. Ten vzniká 

ihned po rozhodnutí o realizaci projektu a jde o předběžný odhad celkových výdajů. 

Aproximativní rozpočet lze sestavit již na základě literárního scénáře a to i v jeho prvních 

verzích. K upřesnění takového aproximativního rozpočtu dochází se vznikem natáčecího 

plánu. Může se jednat o samostatný dokument oddělený od rozpočtu, který vzniká později 

rozepsáním kategorií, upřesněním položek a informací o ceně. „Stejně jako spisovatel musíte 

všechno vložit na papír a začít revidovat.“9 

Aproximativní rozpočet nejčastěji bývá součástí průzkumu realizace AV díla. Pomáhá 

realizovat představu o finanční náročnosti díla. V této fázi se mimo jiné zjišťuje, zda je daný 

projekt možné realizovat a za jakých podmínek. Bez odhadu celkových finančních nákladů 

by tato fáze výroby nemohla proběhnout.  

 
8 LANDRY, cit. 11, s. 112. 
9 RYAN, cit. 9, s. 100. 
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1.3 Faktory ovlivňující sestavení rozpočtu 

Proces sestavení rozpočtu lze podle Landry rozdělit na tři samostatné fáze: 

• identifikovat a obdržet cenu všech položek,  

• vyjednat potencionální dohody a podle nich pozměnit rozpočet, 

• uzavřít dohody písemnými smlouvami.10 

Samotné sestavení rozpočtu je primárně vázáno na natáčecí plán, který definuje počet 

natáčecích dní, nasazení herců, nasazení lokací apod. Všechny tyto informace jsou pro 

sestavení přesného rozpočtu stěžejní. Pokud dojde ve změně v natáčecím plánu, rozpočet se 

musí revidovat a případně aktualizovat. 

Pro sestavení natáčecího plánu je nezbytné vytvořit breakdown script neboli rozložení 

scénáře na technické složky. Tyto složky jsou pro sestavení rozpočtu velmi nápomocné. 

Objevují se v nich všechny položky ze scénáře potřebné pro natáčení včetně speciálních 

nároků jako jsou efekty, kaskadéři, vozidla apod., které je třeba do rozpočtu zanášet.  

Každý hraný film má jinou podobu a vzniká za jiných podmínek. Originalita každého AV 

díla vychází z rozhodnutí, která jej ovlivňují. Většinu těchto rozhodnutí je třeba učinit ještě 

před sestavením rozpočtu. Ta nejdůležitější rozhodnutí se týkají obsazení, formátu natáčení, 

lokací a délky natáčení. Například zvolený formát ovlivňuje celou řadu věcí týkající se 

techniky nebo složení kamerové složky štábu. Výběr lokací zase ovlivňuje náklady 

v dopravě, ubytování a zázemí. Nebo rozhodnutí stavět některé lokace v ateliéru jsou 

určující pro rozpočet.  Méně důležitá rozhodnutí, avšak stejně podstatná pro sestavení 

rozpočtu, jsou ta, která se týkají postprodukce, hudby, dopravy, cateringu či stylizace 

rekvizit, kostýmů a masek. 

Aby mohl být rozpočet kompletní, je třeba tato rozhodnutí učinit. Pochopitelně tvůrce 

rozpočtu nemůže všechna rozhodnutí učinit sám a jedná se většinou o společné rozhodnutí 

hlavních tvůrců.  

1.4 Etika rozpočtu 

Rozpočet je považován za důvěrný dokument producenta, neboť v sobě nese informace, 

které mohou souviset s výrobní strategií nebo výrobními postupy producenta. Proto bývá 

 
10 LANDRY, cit. 11, s. 109. 
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jeho šíření omezeno pouze na okruh lidí, kteří rozpočet ke své práci nezbytně potřebují, 

převážně členové štábu v oddělení producenta. 

Pro investory, sponzory a jiné finančně zainteresované subjekty AV díla je většinou 

k dispozici již zmíněná přední strana rozpočtu se sumarizací všech kategorií, která 

neobsahuje jednotlivé detailní položky, ale pouze výpis se součty jednotlivých kategorií z 

rozpočtu. Nejedná se však o pravidlo, ale o obecnou pomůcku sloužící k přehlednosti. Při 

vyžádání investora o detailní rozpočet mu je pochopitelně předložen. 

Vedoucí oddělení, kteří ke své práci potřebují pracovat s financemi jako lokační manažeři, 

vedoucí výpravy apod., pak mívají standardně k dispozici pouze tu část z rozpočtu, která se 

týká jejich oddělení, nikoliv celý rozpočet.  

Tato opatření je třeba učinit i z toho důvodu, aby nedocházelo ke sporům mezi jednotlivými 

členy štábu. Často bývají výše finančních prostředků pro jednotlivá oddělení a nebo honoráře 

jednotlivých členů štábu určeny na základě domluvy a nebo vyjednávání s producentem. 

Proto není žádoucí výsledky takovýchto dohod veřejně šířit, neboť by mohly znepříjemnit 

vyjednávací pozici oběma stranám na jiných projektech.  
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2 SESTAVENÍ ROZPOČTU V PROGRAMU MOVIE MAGIC 

BUDGETING 

Program Movie Magic Budgeting (dále MMB) je počítačový software od společnosti 

Entertainment Partners, který slouží výhradně pro vytvoření rozpočtu a práci s ním. 

Disponuje propracovaným systémem a nástroji, které usnadňují veškerou manipulaci 

s rozpočtem. Umožňuje přizpůsobení vzhledu a rozložení rozpočtu dle potřeb projektu. 

Jelikož je program vyvinut pro účely filmové produkce, disponuje funkcemi ušitými na míru 

pro stavbu rozpočtu k AV dílu.  

„Firma Entertainment Partners, výrobce programu Movie Magic Scheduling a Movie Magic 

Budgeting, usnadnila a zefektivnila práci s plánováním mnoha filmovým producentům a 

udělala jejich životy snazšími a v mnoha případech je i zachránila.11 

V této kapitole je popsán postup pro sestavení rozpočtu AV díla s podrobným popisem 

použitých funkcí. Postup je psán chronologicky od nastavení projektu až po export rozpočtu.  

2.1 Vytvoření nového projektu

Pro sestavení rozpočtu v programu MMB existuje spousty šablon přímo od společnosti, 

která program vyvinula. Filmová studia dokonce poskytla své šablony, které jsou skrze 

program MMB volně dostupné. Pro práci s rozpočtem v českých podmínkách však nemají 

tyto šablony přílišný užitek. Je tedy třeba vytvořit nový rozpočet od základu.  

2.1.1 Nový rozpočet 

Po spuštění programu je třeba zvolit vytvoření nového, prázdného rozpočtu v záložce File > 

Create Blank Budget (obr. 2.1).  

Obrázek 2.1 – Vytvoření nového, prázdného rozpočtu 

 
11 WURMFELD, cit. 10, s. xiii. 
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2.1.2 Nastavení projektu 

K základnímu nastavení projektu lze použít nástroj Budget Information v záložce File > 

Budget Information. Nástroj obsahuje informace o projektu jako umístění projektu 

v počítači, datum vytvoření, nebo datum poslední úpravy. V pravém sloupci nástroj 

sumarizuje všechny elementy, které jsou obsaženy v rozpočtu jako počet jednotlivých 

položek v různých úrovních rozpočtu. V nástroji lze doplnit název rozpočtovaného projektu 

v kolonce Budget Title, údaj o pořadovém číslu rozpočtu v kolonce Budget Number a údaj 

Revision Number neboli verze rozpočtu (obr. 2.2). 

Obrázek 2.2 – Nástroj Budget Information 

2.1.3 Nastavení jednotek 

V této první fázi je vhodné nastavit jednotky, které se při vytváření rozpočtu používají. 

Slouží k tomu nástroj Setup Units v záložce Setup > Units. Lze v něm upravit defaultně 

nastavené jednotky podle vlastních potřeb anebo přidat nové pomocí tlačítka „Add a row“ 

(obr. 2.3). Každý řádek představuje jednu jednotku, u které lze nastavit hodnota Key, která 

slouží jako zkratka při zadávání položek do rozpočtu. Do sloupců Singular a Plural lze 

doplnit jednotné a množné tvary dané jednotky. Defaultně nastavené jednotky lze přepsat do 

češtiny, ale jelikož v českém jazyce se tvary množného čísla skloňují, výsledek nemusí dávat 

smysl. Do posledního sloupce lze zadat přepočet každé jednotky na hodiny. Pokud se plánuje 

natáčet ve 12 hodinových směnách, kolonka u jednotky Day by měla být 12. Jednotka 

pracovního týdne je denní směna krát 5. V mém případě tedy 60. Jednotka pracovního 

měsíce je 240 (20 krát denní směna). Pokud jednotka nemá hodinový ekvivalent, pole se se 

zanechá prázdné a program sám doplní výraz „No“. Pro sestavení rozpočtu v českých 

podmínkách je užitečné přidat jednotky jako „Paušál“, „Global“, „Odhad“, „Smluvní“ nebo 
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„Ks“ (Kusů). Další jednotky lze přidat dle potřeb plánovaného rozpočtu anebo vlastních 

preferencí.  

Obrázek 2.3 – Nástroj Setup Units 

2.1.4 Nastavení měny 

Program MMB umožňuje sestavovat rozpočet v různých měnách najednou a podle zadaného 

kurzu rovnou přepočítává konkrétní částky. Nastavit měnu lze v nástroji Setup Currencies 

v záložce Setup > Currencies. Tlačítkem „Add a row“ lze přidat novou měnu (obr. 2.4). 

Každý řádek slouží k nastavení hodnot dané měny. První sloupec „Conv“ označuje měnu, 

která se bude zobrazovat ve všech součtech rozpočtu. Tato funkce poslouží v případě, když 

je žádoucí celý rozpočet přenést do cizí měny, ale vstupní hodnoty je nutné zachovat. Měna 

označená ve sloupci „Base“ je hlavní měna, do které se převádí všechny částky v rozpočtu 

a podle které se přepočítává kurz ostatních měn. Do sloupce „Name“ se uvádí název, nebo 

zkratka měny. Do sloupce „Description“ lze zadat popis měny. Do sloupce „Smbl“ lze 

umístit symbol dané měny. Aktivní políčko ve sloupci „Rt“ umístí uvedený symbol na 

pravou stranu měny (např. 1000 Kč). Do sloupce „Sep“ lze umístit symbol, který bude 

oddělovat řády v zadaných částkách (například 1,000,000 Kč). V posledním sloupci „Rate“ 

se zadává kurz měny vůči měně označené jako hlavní (Base). Ta má vždy hodnotu 1.0. Pro 
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účely svého rozpočtu jsem přidal měnu Českou korunu a Euro. Českou korunu jsem označil 

jako hlavní měnu (obr.2.4). Euro lze přidat z přednastavených měn při výběru z nabídky 

„Quick Pick“ (obr. 2.4). Kurz vůči koruně je však třeba doplnit manuálně.  

Obrázek 2.4 – Nástroj Setup Currencies 

2.1.5 Nastavení titulků 

Nástroj Setup Captions, který lze otevřít v záložce Setup > Captions, umožňuje změnit 

jakýkoliv nadpis či titulek v celém rozpočtu. Je tedy možné například přepsat celý rozpočet 

do českého nebo jiného jazyka. V českém prostředí se však anglické názvy běžně používají 

a proto jedinou změnu, kterou jsem pro potřeby svého rozpočtu udělal, byla změna výrazu 

„Fringes“ na DPH (obr. 2.5). Fringes se v programu MMB používá k nastavení poplatků 

asociacím a oblastem, ve kterých se natáčí. V českém prostředí však nejsou tyto poplatky 

běžné a tak je možné tuto funkci pozměnit na umístění daně z přidané hodnoty do rozpočtu 

viz kapitola 2.3.3 Nastavení DPH / Fringes.    

Obrázek 2.5 – Nástroj Setup Captions 
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2.1.6 Nastavení číslování 

Jak již bylo zmíněno v kapitole 1.1 Struktura, standardem při používání rozpočtu je 

označování kategorií a dalších položek v rozpočtu pomocí Account codes neboli účetního 

čísla. Označování pomocí čísel slouží nejen k přehlednému členění rozpočtu, ale v programu 

MMB lze pomocí kódů položky vyhledávat, přidávat je do určitých kalkulací a díky kódům 

lze také porovnávat různé rozpočty mezi sebou pomocí nástroje Budget Comaparsion, 

kterému se věnuji později v této práci. Před samotným vytvořením rozpočtu je vhodné 

nastavit formát tohoto číslování v nástroji Budget Preferences, který lze otevřít v záložce 

Setup > Budget Preferences. Nástroj umožňuje mimo jiné nastavit font, ve kterém se bude 

obsah rozpočtu zobrazovat. Pro účely nastavení Account Codes je zde sekce Account Format 

(obr. 2.6). Nabídka Category Width určuje počet čísel, kterými jsou označovány jednotlivé 

kategorie. Nabídka Account Width určuje počet čísel pro druhou úroveň rozpočtu neboli 

Account Level. Nabídka SubAccount Width dává možnost přidat určitý počet dalších čísel 

do formátování. Nabídka Category/Account Separator umožňuje tyto tři čísla oddělit 

pomlčkou nebo mezerou. V českých podmínkách se běžně používá 4 místné formátování 

oddělené pomlčkou (11-00). Stejné jsem nastavil i pro účely mého rozpočtu (obr 2.6). 

Obrázek 2.6 – Nástroj Setup Preferences 
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2.2 Sestavení rozpočtu 

Po nastavení rozpočtu lze přistoupit k vložení dat a samotné stavbě rozpočtu.  

2.2.1 Nastavení připomenutí ukládání 

Ještě před tím se doporučuje nastavit automatické připomenutí ukládání projektu pomocí 

nástroje Save Reminder. Ten se otevře v záložce Options > Save Reminder. Ve starších 

verzích programu MMB (verze 6 a nižší), umožňoval nástroj nastavit automatické ukládání 

projektu. Ve verzi 7 už tento nástroj pouze připomíná uložení projektu po nastavených 

časových intervalech (obr 2.7). 

Obrázek 2.7 – Nástroj Save Reminder 

2.2.2 Vytvoření kategorií 

V okně s názvem TopSheet, které se otevře společně s novým projektem, lze vidět první 

vrstvu vytvořeného rozpočtu zatím bez jakýchkoliv dat. Do první vrstvy se zadávají hlavní 

kategorie rozpočtu a lze toho docílit kliknutím do prvního řádku ve sloupci „Category 

Description“ a zadáním názvu kategorie (obr. 2.8). Do prvního sloupce označeného „Acct#“ 

se zadává Account code neboli účetní číslo. Program číslo formátuje podle zadaného 

nastavení viz kapitola 2.1.6 Nastavení číslování. Hodnoty do sloupce „Page“ a „Total“ 

doplňuje program automaticky. Sloupec „Page“ označuje na jaké stránce v exportu rozpočtu 

lze danou kategorii nalézt a ve sloupci „Total“ je výsledný součet položek v dané kategorii.  

Obrázek 2.8 – Vložení kategorie 

Nejrychlejší způsob zadávání dat je pomocí klávesy Tabulátor nebo Enter. Ta přesune 

označení na další buňku, do které je možné rovnou psát. Na konci řádku se po stisknutí 

klávesy vytvoří nový, prázdný řádek. Nové řádky lze přidávat také pomocí klávesové 

zkratky CTRL + i / CMD + i. 
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2.2.3 Production Total 

Po vložení kategorií lze rozdělit rozpočet na části „Above The Line“ a  „Below The Line„ 

viz kapitola 1.1 Struktura. Rozdělení lze docílit pomocí řádku „Production Total“. Ten 

umožňuje sečíst kategorie umístěné v rozpočtu nad ním. Řádek se do rozpočtu vloží pravým 

klikem myši na šedý sloupec s číslováním řádků a zvolením možnosti „Insert Production 

Total“ (obr. 2.9). Řádek se součtem se vloží nad vybraný řádek. Řádek Production Total lze 

libovolně přejmenovat kliknutím na něj, stejně jako jakýkoliv jiný řádek. 

Obrázek 2.9 – Umístění Production Total 

Program automaticky přidá na spod rozpočtu tři mezisoučty (obr. 2.10). „Total Above-The-

Line“, který sčítá kategorie nad vloženým řádkem Production Total. „Total Below-

The_Line“ sčítá kategorie pod tímto řádkem a „Total Above and Below-The-Line“ je 

součtem obou rozdělení. 

Obrázek 2.10 – Mezisoučty 

 

2.2.4 Navigace v rozpočtu 

Program MMB využívá pro práci s rozpočtem 4 úrovně. Hlavní stranu „TopSheet“ s 

kategoriemi, druhou vrstvu „Account Level“ s položkami, třetí vrstvu „Detail Level“ pro 
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rozepsání položek a čtvrtou vrstvu „4th Level“, která slouží k doplňujícím počtům. První 3 

vrstvy vytvářejí hlavní strukturu rozpočtu a lze mezi nimi procházet několika způsoby. Do 

čtvrté úrovně je samostatný přístup.  

Hlavní dva nástroje pro pohyb mezi vrstvami jsou navigační koule a 4 ikony v horním panelu 

programu (obr. 2.11). Ikona s písmenem „T“ vede na hlavní stranu rozpočtu neboli 

„Topsheet“. Druhá ikona s písmenem „A“ vede do druhé úrovně, třetí ikona s písmenem „D“ 

vede do třetí vrstvy a poslední ikona s číslem „4“ otevře nové okno pro správu doplňujících 

počtů. Pomocí navigační koule je možné mezi vrstvami snadno procházet. Šipka dolů vede 

vždy do hlubší úrovně, naopak šipka nahoru otevře o stupeň vyšší vrstvu. Šipkami vpravo a 

vlevo lze přecházet ve vybrané úrovni mezi dalšími položkami podle toho, v jaké úrovni se 

používá. Navigační kouli lze zastoupit pomocí šipkami na klávesnici, které společně se 

stiskem klávesy CTRL / CMD plní stejnou funkci.  

Obrázek 2.11 – Navigační nástroje 

Mimo tyto nástroje lze do spodnějších vrstev vstupovat kliknutím na číslo (v levém šedém 

sloupci), které je u každého řádku s kategorií nebo položkou (obr 2.12). Tím se otevře 

spodnější vrstva vybrané kategorie nebo položky. 

Obrázek 2.12 – Přechod do spodní vrstvy vybrané kategorie / položky 

2.2.5 Vytvoření položek v druhé úrovni 

Jednotlivé účetní položky lze vytvořit stejným způsobem jako kategorie. Po vstupu do druhé 

úrovně vybrané kategorie se otevře okno s názvem a účetním číslem dané kategorie (obr 

2.13). Do něj lze přidávat jednotlivé účetní položky. Do prvního sloupce se umisťuje účetní 
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kód. Jeho první dvojčíslí zpravidla koresponduje s danou kategorií a druhé dvojčíslí již 

označuje jednotlivé položky. Do druhého sloupce se zadává název účetní položky (obr 2.13). 

Obrázek 2.13 – Okno v druhé úrovni vybrané kategorie 

2.2.6 Doplnění dat do třetí úrovně 

V prvních dvou úrovních rozpočtu lze zadávat pouze účetní kódy a názvy kategorií a 

položek. Až ve třetí úrovni (Detail Level) lze do jednotlivých položek umisťovat informace 

o částce a kalkulaci. Po vstupu do této třetí úrovně skrze vybranou položku z druhé úrovně 

se otevře nové okno, ve kterém lze zadávat konkrétní položky a k nim veškeré informace. Je 

zde celá řada sloupců, které lze zobrazit nebo naopak schovat pomocí šesti tlačítek v horní 

části okna (obr. 2.14).  

Obrázek 2.14 – Tlačítko pro zobrazení sloupců 

První tlačítko „AGG“ zobrazuje sloupec s informací o procentuálním podílu Fringes 

(asociačních poplatků) dané položky. Druhé tlačítko „FRIN“ zobrazuje sloupec 

s informacemi o tom, jaké poplatky (Fringes) jsou k dané položce přiřazeny. Tlačítko „GRP“ 

zobrazí sloupec s informací o tom, k jakým skupinám je daná položka přiřazena. Tyto první 

3 sloupce mají pouze informativní funkci a nelze do nich psát. Další tlačítko „LOC“ a „SET“ 

zobrazí sloupce, skrze které lze položky přidávat do vytvořených skupin podle lokace nebo 

setu. Poslední tlačítko „CUR“ zobrazí sloupec, do kterého lze zadat v jaké měně je daná 

položka kalkulována. 

V této fázi vkládání dat zatím nejsou tyto sloupce k užitku a tudíž jsou v mém rozpočtu 

prozatím ponechány skryté (obr. 2.15) 

Obrázek 2.15 – Detail Level po skrytí sloupců 

Zbylé sloupce slouží k umístění konkrétních informací o částce a kalkulaci. První sloupec 

„Description“ slouží k umístění názvu položky. Do sloupce „Amt“ se zadává počet jednotek. 
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Do dalšího sloupce „Units“ se umístí jednotka (Den, Týden, Paušál, Global apod.). Sloupec 

„X“ násobí počet jednotek zadaným číslem a do sloupce „Rate“ se zadává cena za jednotku. 

Kombinace údajů ve sloupcích „Amt“, „Units“, „X“ a „Rate“ vypočítá celkovou částku za 

danou položku a program ji zobrazí ve sloupci „Sub T“. Zjednodušeně lze říci, že sloupce 

označují „Kolik“ „Čeho“ „Krát“ „Cena“. 

Vložené informace nejsou omezeny pouze na čísla. Lze zadávat například procenta, 

matematické vzorce, anebo propočty z nástroje Global viz kapitola 2.2.8 Nastavení Globals.  

Do sloupce „Units“ stačí napsat zkratku pro nastavenou jednotku viz kapitola 2.1.3. 

Nastavení jednotek. Program zadanou zkratku přepíše na celou jednotku, kterou představuje 

a v kalkulaci již počítá se zadanými hodnotami (D = Day = 12 hodin).  

Výsledkem doplnění informací v této fázi je kompletní základní stavební buňka celého 

rozpočtu. Tou je konkrétní položka s vypočítanou sumou, zařazená v patřičné účetní 

položce, která spadá do patřičné kategorie v rozpočtu (obr. 2.16). 

Obrázek 2.16 – Doplněné položky ve 3. úrovni 

2.2.7 Import dat z programu Movie Magic Scheduling 

V této fázi sestavování rozpočtu je příhodné využít jednu z výhod propojení programů 

Movie Magic Scheduling (dále MMS) a Movie Magic Budgeting. Pokud má rozpočtovaný 

projekt sestavený natáčecí plán v programu MMS, jdou z něj importovat data do rozpočtu. 

V programu MMS stačí natáčecí plán exportovat v záložce File > Export a při ukládání zvolit 

formát uloženého souboru „Movie Magic Budgeting 7.0 or higher“, který je v nabídce. Dále 

se v MMB tento uložený formát otevře pomocí nástroje „Library“ neboli Knihovna.  Po 

otevření nástroje v záložce Library > Open Library File je třeba vybrat exportovaný soubor 
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z MMS, který do nástroje umístí novou složku, která obsahuje všechny elementy vytvořené 

v natáčecím plánu jako jsou herci, auta, lokace apod. (obr. 2.17). 

Obrázek 2.17 – Nástroj Library 

Nyní stačí ve vybrané třetí úrovni rozpočtu označit řádek, v nástroji Library zvolit kategorii 

elementů a kliknout na tlačítko Insert (obr. 2.18). Program do vybrané úrovně, nad vybraný 

řádek, umístí všechny elementy ze zvolené kategorie a do sloupce „Amt“ umístí číslo podle 

počtu nasazených dnů, které se u daného elementu v natáčecím plánu objevují. 

Obrázek 2.18 – Vložení dat z nástroje Library 

Vložení dat z MMS lze učinit v jakékoliv kategorii a je velmi praktickým nástrojem při 

stavbě rozpočtu. Závisí však na pečlivě vytvořeném natáčecím plánu. Je také nezbytné 

zbytek informací o jednotce, jejím násobku a ceně doplnit manuálně. 
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2.2.8 Nastavení Globals 

Velice praktickým asistentem pro stavbu rozpočtu je nástroj Globals. Používá se při zadávání 

hodnot do rozpočtu a lze v něm nastavit libovolné množství zkratek, které zastupují zadané  

hodnoty jako například celkový počet natáčecích dní, počet přípravných dní, počet 

pracovních týdnů apod. Tyto hodnoty se dají kdykoliv upravit a provedené změny se 

následně projevují napříč celým rozpočtem, aniž by uživatel musel vše přepisovat manuálně.  

Nástroj se otevře v záložce Setup > Globals anebo pomocí ikony se symbolem zeměkoule 

na hlavním panelu (obr. 2.19). Po otevření nového okna s nástrojem se pomocí ikony se 

symbolem zeměkoule a znaménkem „+“ (obr. 2.20) vytvoří prázdný řádek pro zadání nové 

hodnoty Global.  

Obrázek 2.19 – Ikona pro otevření nástroje Globals 

Obrázek 2.20 – Ikona pro vytvoření nové hodnoty Global 

Ve sloupci „In-Use“ program automaticky doplňuje celkový počet umístění vybrané 

hodnoty Global v rozpočtu. Zaškrtávací box ve sloupci s písmenem „D“ umožňuje 

zobrazovat v rozpočtu název hodnoty Global namísto výsledné číselné hodnoty. Tato funkce 

může sloužit ke kontrole použitých hodnot Global v rozpočtu. Do sloupce „Name“ se zadává 

zkratka, která bude v rozpočtu výslednou hodnotu Global zastupovat. V dalším sloupci 

„Description“ lze umístit její delší popis. Sloupec „Calculation“ umožňuje zadat 

požadovanou kalkulaci. Do sloupce „Units“ se zadává jednotka z přednastavené tabulky viz 

kapitola 2.1.3 Nastavení jednotek. Do sloupce „Dec“ lze napsat číslo, které udává, na kolik 

desetinných míst se bude výsledná hodnota zaokrouhlovat. Do posledního sloupce „Value“ 

program automaticky dopočítá výslednou hodnotu, kterou bude daná zkratka v rozpočtu 

reprezentovat.  

Zadávání hodnot není omezeno pouze na čísla. Lze zadávat matematické vzorce a případně 

vzájemně kombinovat jiné hodnoty Global. Pro účely mého rozpočtu a jako příklad jsem 

nastavil následující hodnoty pro kalkulaci lokačního manažera (obr. 2.21): 
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- SC = scouting lokací – 25 x Days = hodnota 25, 

- LDL = celkový počet likvidačních dní pro lokačního – 10 x Days = hodnota 10, 

- ND = celkový počet natáčecích dní – 30 x Days = hodnota 30, 

- LT = celkem všech dní lokačního – SC+ND+LDL = hodnota 65. 

Obrázek 2.21 – Nastavení hodnot pro kalkulaci lokačního manažera 

Po nastavení těchto hodnot Global lze během kalkulace položky lokačního manažera napsat 

do sloupce „Amt“ zkratku, která zastupuje potřebnou hodnotu a program ji automaticky 

doplní (obr. 2.22).  

Obrázek 2.22 – Zadání zkratky do rozpočtu 

Během kalkulace dopravy pak lze znovu čerpat z výhod nástroje Global a u položky doprava 

lokačního manažera lze rozpočtovat amortizaci jeho vozu smluvní částkou za den krát počet 

jeho celkových pracovních dní. Ty se automaticky propočítávají v nástroji Global, 

reprezentuje je vytvořená zkratka „LT“, a kdyby došlo ke změně počtu přípravných, 

natáčecích nebo likvidačních dní lokačního manažera, součet v nástroji Global takovou 

změnu zachytí a rozdíl se v rozpočtu rovnou projeví.  

Nástroj Global se vyplatí používat napříč celým rozpočtem, neboť významně usnadňuje 

reagování rozpočtu na změny ve výrobním procesu.  
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Pro větší kontrolu během zadávání hodnot Global do rozpočtu slouží první sloupec ve třetí 

vrstvě rozpočtu s názvem „Ind.“. Pokud je u položky použita hodnota Global, právě v tomto 

prvním sloupci se u položky zobrazí malá ikona se symbolem zeměkoule (obr. 2.23). 

Obrázek 2.23 – Ikona signalizující použitou hodnotu Global 

2.2.9 Kopírování položek 

V rámci práce s programem MMB lze používat funkci zkopírování a vložení vybraných 

položek do dalších kategorií. Výhodou je skutečnost, že společně s kopírovanou položkou 

se zkopírují i umístěné Global hodnoty. Například při stavbě rozpočtu kamerového štábu, 

který má většinou stejný počet přípravných, natáčecích i likvidačních dní je tato funkce 

velmi přínosná.  

Pro zkopírování všech řádků v dané účetní položce stačí kliknout na levou horní buňku, 

pomocí které se označí všechny řádky. Pravým klikem na číslování řádku se otevře nabídka, 

ve které je třeba zvolit „Copy Row“. Po přechodu do účetní položky, do které se kopíruje, 

je třeba opět kliknout na číslování řádku pravým tlačítkem a zvolit „Paste Row“ (obr 2.24). 

Výběr řádku se společně se všemi hodnotami zkopíruje na vybrané místo.  

Obrázek 2.24 – Kopírování řádků 

Funkci lze aplikovat i na druhé úrovni rozpočtu a lze kopírovat i celé kategorie na úvodní 

stránce „Topsheet“. V takovém případě se zkopíruje i celý obsah kopírované kategorie tzn. 

všechny účetní položky z druhé úrovně i se všemi položkami na jejich třetí úrovni.  
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2.2.10 Přidání sloupců 

Ve třetí úrovni rozpočtu lze přidat 4 další sloupce pro vkládání jednotek a hodnot. Pravým 

klikem na horní lištu se rozbalí nabídka přídavných sloupců (obr 2.25). „4th Multiplier“ 

přidá sloupec se stejnou funkcí jako má sloupec „X“. Umístěnou hodnotou se násobí zbytek 

položky. „2nd Unit“, „3rd Unit“ a „4th Unit“ přidají sloupce pro vkládání jednotek, které se 

umístí za sloupec „X“, za sloupec s částkou „Rate“ a za sloupec „4th Multiplier“. Tyto 

přídavné sloupce slouží hlavně ke zpřehlednění položek.  

Obrázek 2.25 – Nabídka přídavných sloupců 

V případě mého rozpočtu nechávám zobrazený druhý sloupec s jednotkami „2nd Unit“ 

například při rozpočtování komparzu. První sloupec udává počet osob a v případě, že se 

některá skupina komparzistů bude v natáčecím plánu opakovat, lze to promítnout ve sloupci 

„X“ a pro přehlednost přidat do sloupce „2nd Unit“ jednotku Day (obr. 2.26). 

Obrázek 2.26 – Využití přídavného sloupce 

2.2.11 Mezisoučty 

Na rozpočtování komparzu lze dobře popsat funkci mezisoučtů. Program MMB umožňuje 

do jakéhokoliv řádku ve třetí úrovni rozpočtu přidat řádek „Subtotal“, který zobrazí součet 
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všech položek umístěných nad ním. Mezisoučet lze přidat pravým klikem myši na řádek 

s číslováním a zvolením možnosti „Insert SubTotal“ (obr. 2.27).  

Obrázek 2.27 – Přidání mezisoučtu 

Je však možné v nabídce zvolit možnost „Insert SubTotal Adjustment“, která také přidá 

řádek s mezisoučtem, ten se však započítá do celkové kalkulace. Řádek lze upravovat stejně 

jako jakoukoliv položku s tím rozdílem, že ve sloupci „Rate“ je fixní součet všech položek 

umístěných nad ním. V případě kalkulace komparzu lze díky této funkci spočítat například 

provizi agentury v případě, že vychází z celkové sumy utracené za komparz. Do sloupce 

„Amt“ se tato provize napíše v procentech, v případech mého rozpočtu 10%, a program 

spočítá tento podíl z celkové sumy (obr 2.28). 

Obrázek 2.28 – Přidání provize 

Výhoda je opět v plné automatizaci. Pokud se změní počet komparzistů, změní se i celková 

suma, na kterou mezisoučet i podíl z něj ihned zareaguje. Tímto způsobem se dá počítat i 

DPH, není to však jediný způsob viz kapitola 2.2.16 Nastavení DPH / Fringes. 
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2.2.12 Čtvrtá úroveň rozpočtu 

Během stavby rozpočtu se běžně stává, že je potřeba některé položky více a podrobněji 

rozepsat. K tomu slouží čtvrtá úroveň rozpočtu „4th Level“, která už není jen podúrovní, ale 

funguje jako soubor samostatných rozpisů.  

Přehled rozpisů na čtvrté úrovni se otevře ikonou s číslicí „4“ na hlavním panelu. Do 

prázdného pole se napíše název rozpisu, který se vytvoří tlačítkem „Create“ (obr. 2.29).  

Obrázek 2.29 – Vytvoření rozpisu 

Kliknutím na nově vytvořený rozpis se otevře tabulka připomínající klasický tabulkový 

program nejen vzhledem, ale i funkcemi. Buňky lze jednoduše formátovat pomocí nástrojů 

v záložce Format. Nástroje „Font“ a „Text Color“ upravují font a jeho barvu. Nástroj „Cell 

Color“ obarví vybrané buňky na zvolenou barvu a nástroj „Number Format“ umí formátovat 

čísla ve vybraných buňkách (obr. 2.30). Do buněk je možné kromě standardních tabulkových 

vzorců psát i zkratky z nástroje Global. Program již dále pracuje s hodnotou, kterou 

zastupují. 

Obrázek 2.30 – Nástroje pro formátování buněk a textu 
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Praktickým pomocníkem je tlačítko automatického součtu, které po kliknutí vytvoří ve 

vybrané buňce vzorec pro součet všech buněk nad ní (obr. 2.31). 

Obrázek 2.31 – Funkce automatického součtu 

V mém rozpočtu je tímto způsobem rozepsána částka za dopravu techniky. Výsledná 

hodnota z rozpisu se do rozpočtu přenáší tak, že do položky, kam je potřeba hodnotu umístit 

se napíše symbol „=“ a vybere se buňka v rozpisu s přenášenou hodnotou. Program již doplní 

patřičný vzorec a hodnotu (obr. 2.32).  

Obrázek 2.32 – Přenesení hodnoty ze čtvrté úrovně 

2.2.13 Použití jiné měny 

V kapitole 2.1.4 Nastavení měny je popsán postup k vytvoření a úpravě měn používaných v 

rozpočtu. Jejich aplikování během kalkulace je snadné. Je potřeba otevřít sloupec k tomu 

určený pomocí tlačítka „CUR“ na třetí úrovni rozpočtu (obr. 2.34). K položce, kterou je 
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potřeba změnit na jinou měnu než je ta primární, stačí do nového sloupce „Cur“ napsat 

zkratku měny. Program přepočítá zadanou částku podle nastaveného kurzu do primární 

měny a přepočet zobrazí ve sloupci „Sub T“. V celkovém součtu nadále kalkuluje s tímto 

přepočtem. V případě, že dojde k úpravě kurzu v nastavení měn, změna se projeví ve všech 

položkách označených danou měnou.  

Obrázek 2.33 – Použití jiné měny 

2.2.14 Nastavení skupin 

Program MMB disponuje nástrojem Groups, který umožňuje zařadit jakékoliv položky do 

vytvořených skupin a následně monitorovat jejich celkový součet, vyloučit je z celkové 

kalkulace nebo pomocí jiných nástrojů na ně aplikovat další výpočty. Nástroj lze otevřít 

v záložce Setup > Groups.  

V otevřeném nástroji lze přidat novou skupinu pomocí tlačítka „Add a row“ (obr. 2.34).  

Obrázek 2.34 – Nástroj Groups 

Do řádku představující novou skupinu lze zadat její název ve sloupci „Name“, podrobnější 

popis ve sloupci „Description“, zkratku skupiny ve sloupci „ID“. Zkratka se bude zobrazovat 

v rozpočtu u položek, které do dané skupiny patří. Zaškrtávací pole ve sloupci „Include in 

Budget Totals“ umožňuje všechny položky z dané skupiny vyloučit z rozpočtu. Položky 

zůstanou v rozpočtu označeny šedě s nápisem „Excluded“ a do celkového součtu se nadále 

nezahrnují. Ve sloupci „Color“ je možné nastavit jakou barvou se budou položky dané 

skupiny v rozpočtu zobrazovat. Ve sloupci „Line“ program zobrazuje celkový počet 
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zahrnutých položek a sloupec „Total“ zobrazuje součet jejich celkové částky. „Sloupec 

„Active Total“ ukazuje součet aktivních položek. V případě, že bude celá skupina z rozpočtu 

vyloučena, číslo v tomto sloupci bude 0.  

Pro účely mého rozpočtu jsem nastavil skupinu „Slovensko“ pro zahrnutí těch položek 

z rozpočtu, které budou obsahovat dodavatele ze Slovenska. Při projektech s mezinárodními 

koprodukcemi a možnostmi čerpání zahraničních fondů je tento nástroj velmi praktickým 

pomocníkem.  

Umístění položek do skupin probíhá v rozhraní rozpočtu. Pomocí ikony na hlavním panelu 

se otevře okno „View/Apply Groups“ (obr. 2.35). Vybrané položky lze přidat do skupiny 

kliknutím na zaškrtávací box v nástroji. Položky změní barvu podle nastavení a ve sloupci 

„Grp“ se zobrazí nastavená zkratka dané skupiny. Sloupec lze zobrazit tlačítkem „GRP“ na 

horním panelu. 

Obrázek 2.35 – Přidání položek do skupiny 
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2.2.15 Nastavení Lokací a Setu 

Dva prakticky stejné nástroje Locations a Sets fungují na podobném principu jako nástroj 

Groups. Umožňují přidat jakékoliv položky do skupin podle lokace nebo setu, na kterém 

budou dané položky potřeba. Na rozdíl od nástroje Group disponují tyto nástroje pouze 

zobrazením celkového součtu položek zařazených v dané skupině. Je díky nim možné 

přehledně monitorovat finanční náročnost vybraných lokací nebo scén. 

Nástroje je možné otevřít v záložce Setup > Locations a Setup > Sets. V otevřeném nástroji 

lze přidat novou skupinu pomocí tlačítka „Add a row“ (obr. 2.36). Do nového řádku lze zadat 

název skupiny ve sloupci „Name“, podrobnější popis ve sloupci „Description“. Do třetího 

sloupce „Total“ program doplňuje celkový součet položek dané skupiny. Na třetí úrovni 

rozpočtu lze pomocí tlačítek „LOC“ a „SET“ v horním panelu otevřít sloupce, do kterých 

lze následně napsat název skupiny. Tím se položka přidá do skupiny vytvořené v nástroji 

Locations nebo Sets. 

Obrázek 2.36 – Nástroj Locations 
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2.2.16 Nastavení Credit 

Nástroj Credit umožňuje zakomponovat do rozpočtu finanční příjem projektu jako jsou 

například filmové pobídky z regionů a státních fondů nebo jiné finanční příspěvky. Nástroj 

jednoduše vytvoří skupinu položek a podle zadaných hodnot vypočítá jejich částku. Tu je 

následně možné z celkového rozpočtu odečíst. Je možné nastavit libovolné množství 

Creditů. To je ideální pro projekty s mezinárodními koprodukcemi, které čerpají pobídky a 

příspěvky ze svých státních fondů, ale i pro projekty, které v rámci natáčení plánují čerpat 

finance z vícero regionálních fondů.  

Obrázek 2.37 – Nástroj Credit 

Nástroj se otevře pomocí ikony se symbolem „(Cr)“ na hlavním panelu (obr. 2.37). V horní 

části lze vybraný Credit pojmenovat v kolonce „Name“. Do kolonky „Applied Credit Cap“ 

lze zadat maximální výši daného Creditu, pokud nějakou má. V kolonce „Account Number“ 

lze zadat účetní číslo, které bude ke Creditu přiděleno. Výsledná suma Creditu se totiž 

zobrazí jako samostatný řádek na hlavní stránce rozpočtu (Topsheet). Pro další funkce 

programu MMB, jako je například srovnávání rozpočtů, je nezbytné, aby nějakým účetním 

číslem disponoval. Kolonky „Discount %“ a „Discount Amount“ v pravé části slouží 

k nastavení procentuálního zisku z daného Creditu. V americkém systému rozpočtování tyto 

služby běžně zajišťují agentury nebo makléři, kteří mají ze zprostředkování finančního 

příspěvku procentuální zisk. V českých podmínkách se tento systém nepoužívá, a tak lze 

nechat kolonky prázdné. Poslední kolonka v nastavení „Net Credit“ je automaticky 

doplňována programem a udává celkovou částku Creditu. 
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Spodní část slouží k nastavení jednotlivých položek, ze kterých se sčítá celková výše 

Creditu. Pomocí tlačítka „Include Amt“ se přidá řádek, do kterého lze zadat výchozí částku 

manuálně. Tlačítko „Include Group“ otevře nabídku spravovaných skupin v rozpočtu a 

umožní vybrat skupinu, která se promění v nový řádek s patřičnými hodnotami. V případě 

mého rozpočtu jsem přidal částku 2 500 000 představující finanční příspěvek z fondu a 

skupinu „Slovensko“, která obsahuje všechny položky se slovenskými dodavateli a ze které 

následně půjde vypočítat filmová pobídka. Tlačítko „Exclude Fringe“ umožňuje z pobídky 

vyloučit poplatky Fringes. Tlačítko „Delete“ smaže vybraný řádek.  

Obrázek 2.38 – Nastavení nástroje Credit 

Nejefektivnější způsob, jak nastavit pobídku je používat nástroj Group viz kapitola 2.2.14 

Nastavení skupin. V případě, že dojde k úpravě položek či částek v dané skupině, změna se 

projeví i v nastavené pobídce. Program nabízí ještě další možnost, jak přidávat kategorie 

nebo položky do Creditu manuálně. Stačí v rozpočtu označit patřičnou kategorii, nebo 

položky a otevřít seznam Creditů v záložce Tools > View/Include Applied Credit. Ze 

seznamu je následně třeba vybrat konkrétní Credit, do kterého se označené položky přidají.  

Credit se zobrazuje jako nový řádek umístěný pod celkovým součtem rozpočtu na hlavní 

straně (Topsheet). Společně s ním se vytvoří nový součet rozpočtu, který kalkuluje i se všemi 

vytvořenými Credity. Otevřít Credit a provádět v něm úpravy lze dvojitým kliknutím na 

číslování řádků na úrovni Creditu (obr. 2.39). 

Obrázek 2.39 – Otevření vytvořeného Creditu 
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V nástroji Credit je v prvním sloupci „Type“ rozdělení toho, zda řádek představuje 

uživatelem přidanou sumu (User), přidanou skupinu (Group) anebo zda je řádek přidán 

přímo z některé úrovně rozpočtu (Cat, Acct, Detail). Do druhého sloupce „Name“ je 

automaticky doplněn název vybrané skupiny nebo účetní číslo přidané položky. Ve sloupci 

„Desc“ lze u manuálně přidané sumy umístit její popis. V ostatních případech je sloupec 

automaticky doplněn o název přidané kategorie nebo popis přidané skupiny. Sloupec „Gross 

Total“ zobrazuje celkovou sumu přidané položky či skupiny. V případě manuálně přidané 

částky lze v tomto sloupci nastavit její výši. Sloupec „Excl Fringes“ zobrazuje celkovou 

částku všech vyjmutých poplatků z dané položky a ve sloupci „Net Total“ je částka po 

odečtení poplatků, ze které se počítá výsledná pobídka. Rozbalovací nabídka ve sloupci 

„Cap Type“ umožňuje nastavit individuální maximální výši každé položky a to dvěma 

způsoby. První (QS) umožňuje nastavit v dalším sloupci „Cap“ maximální sumu, ze které se 

bude procentuální podíl položky počítat. Druhá možnost (CR) umožňuje nastavit ve sloupci 

„Cap“ maximální částku, kterou je možné z dané položky obdržet. Pomocí sloupce „%“ lze 

nastavit procentuální podíl výsledné položky. V případě, že součástí Creditu je i jednorázový 

finanční příspěvek, je třeba napsat hodnotu 100%, aby se započítal celý. Ve sloupci „Credit 

Amt“ se zobrazuje spočítaný podíl každé položky. V posledním sloupci „Cap Var“ se 

zobrazuje částka, kterou je v závislosti na nastavené maximální hodnotě položky ještě možné 

čerpat (zeleně označené) anebo kolik peněz je již nad nastavené maximum (červeně 

označené) (obr.2.40). 

Obrázek 2.40 – Položky v nástroji Credit 

Pomocí nástroje je možné vytvořit finanční plán projektu a přímo na něm sledovat vlivy 

rozpočtu. Odečet Creditu od celkového součtu rozpočtu ukazuje, zda je rozpočet finančními 

vstupy pokrytý či nikoliv.  

2.2.17 Nastavení Rezervy 

Obecně se doporučuje v každém rozpočtu stanovit rezervu pro nečekané výdaje. V poučkách 

ohledně rozpočtování se doporučuje rezerva ve výši 10% z celkové výše rozpočtu. V praxi 

je to ovšem individuální u každého producenta. V programu MMB je možné nastavit rezervu 
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pomocí funkce Contractual Charge neboli smluvní poplatek. Jde o vytvoření položky na 

hlavní straně rozpočtu (Topsheet) jejíž částka se počítá na základě nastavení. 

Funkci je možné používat pouze na první úrovni rozpočtu. Nový řádek s Contractual Charge 

lze přidat pravým kliknutím na číslování řádku a z nabídky zvolením „Insert Contractual 

Charge (obr. 2.41). 

Obrázek 2.41 – Vložení Contractual Charge 

V otevřeném okně lze nastavit název poplatku v kolonce „Name“. V kolonce „Charge Type“ 

je možné zvolit, zda se bude poplatek (v případě mého rozpočtu rezerva) počítat 

procentuálním podílem z celkové sumy rozpočtu (Percentage) nebo paušálně nastavenou 

částkou (Flat Fee). Do kolonky „Percentage“ lze napsat procento, pomocí kterého se 

výsledná částka spočítá v případě zvolení procentuálního typu propočtu. Do kolonky „Flat 

Fee“ je možné napsat konkrétní částku v případě zvolení paušálního typu. Kolonka „Account 

Number“ slouží k umístění účetního čísla, které se přidělí k vytvořenému řádku. V kolonce 

„Total Charge“ program zobrazuje výsledný propočet (obr. 2.42). 
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Obrázek 2.42 – Nastavení Contractual Charge 

V nastavení je možné zvolit, aby se nastavené procento propočtu ukazovalo v řádku za 

názvem (Display Percentage in Topsheet Description) a nebo aby se za názvem zobrazovala 

suma celkově vyloučených položek z propočtu (Display Excluded Amount in Topsheet 

Description). K vyloučení vybraných položek z celkového propočtu slouží dolní část 

nastavení. Pomocí tlačítka „Exclude Amt“ lze přidat řádek pro umístění konkrétní částky, 

která se z celkového rozpočtu odečte čímž ovlivňuje výpočet procentuálního podílu. 

Tlačítko „Exclude Group“ umožňuje přidat k vyloučeným položkám celou skupiny 

z nástroje Group. Tlačítko „Delete“ smaže vybranou položku. Stejně jako v nástroji Credit 

lze i v případě Contractual Charge přidat do vyloučených položek jakoukoliv kategorii nebo 

položku z rozpočtu přímo v rozhraní rozpočtu. Stačí vybranou kategorii nebo položky 

označit, otevřít seznam poplatků v záložce Tools > View/Exclude Contractual Charges a 

vybrat konkrétní poplatek, do kterého se kategorie nebo položka přidá a v propočtu 

procentuálního podílu nadále nefiguruje. 

Pomocí této funkce lze do rozpočtu kromě rezervy přidat například částku za pojištění 

projektu, která může v některých případech vycházet z celkové výše rozpočtu.  
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2.3 Práce s rozpočtem 

Po sestavení rozpočtu přichází fáze jeho revidování na základě nastalých změn týkajících se 

úprav scénáře, natáčecího plánu, obsazení, lokací apod. Všechny změny a rozhodnutí 

v přípravné fázi projektu většinou vedou i ke změně rozpočtu a je třeba na ně reagovat. 

Program MMB disponuje několika nástroji, které jsou v této fázi rozpočtování k užitku.  

2.3.1 Monitoring provedených změn 

Jedna z funkcí, která pomáhá držet kontrolu nad částkami a provedenými změnami je 

informační panel změn v horní části rozpočtu (obr. 2.43) 

Obrázek 2.43 – Informační panel 

Na levé straně panelu je kolonka „Budget“, ve které program automaticky zobrazuje celkový 

součet rozpočtu. Panel se zobrazuje na všech úrovních rozpočtu a aktualizuje se po jakékoliv 

provedené změně. V momentě, kdy uživatel vstoupí na druhou úroveň rozpočtu, zobrazí se 

na informačním panelu nová kolonka s účetním číslem dané kategorie a jejím celkovým 

součtem. Při v stupu do třetí úrovně rozpočtu se zobrazí další kolonka s účetním číslem dané 

položky a jejím celkovým součtem.  

Na pravé straně panelu je kolonka „Sess“, ve které se sčítají všechny provedené změny 

v rozpočtu. V případě navýšení částek v rozpočtu součet v kolonce roste, naopak při škrtech 

v rozpočtu součet klesá nebo ukazuje zápornou hodnotu. Hodnotu v kolonce „Sess“ jde 

kdykoliv resetovat na hodnotu 0 tlačítkem „Reset“ na konci panelu.  

Poslední kolonka na panelu „Chng“ zobrazuje poslední provedenou změnu, respektive její 

finanční dopad na rozpočet.  

2.3.2 Varianty rozpočtu 

Program MMB disponuje velmi elegantní funkcí pro přípravu varianty rozpočtu a sledování 

změn. Na první a druhé úrovni rozpočtu lze po kliknutí pravým tlačítkem na horní panel 
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rozpočtu zvolit možnost „Show Original & Variance Columns“ (obr. 2.44). Funkce zobrazí 

na první a druhé úrovni dva nové sloupce s označením „Orig“ a „Var“. 

Obrázek 2.44 – Original & Variance Columns 

Hodnoty ve sloupci „Orig“ se nadále nemění od chvíle, kdy je funkce spuštěna a to i přes 

další provedené změny v rozpočtu. Sloupec tak zachovává původní podobu rozpočtu.  

V rozpočtu lze v tomto stavu nadále dělat jakékoliv úpravy, které se standardně kalkulují ve 

sloupci „Total“. Třetí sloupec „Var“ však s každou změnou v rozpočtu zobrazí rozdíl 

provedené změny mezi aktuálním sloupcem „Total“ a sloupcem „Orig“ s původními 

hodnotami. 

Hodnoty ve sloupci „Orig“ lze aktualizovat zvolením možnosti „Update Original Column 

Totals“ z rozbalovací nabídky horního panelu. Tím se přenesou hodnoty ze sloupce „Total“ 

do sloupce „Orig“, kde se opět zakonzervují do další aktualizace.  

S touto funkcí lze efektivně připravit variantu rozpočtu s možností sledovat a porovnat 

provedené změny s původní verzí.  

V nastavení rozpočtu, které se otevře v záložce Setup > Budget Preferences, lze sloupec 

„Orig“ zamknout, aby ho již nadále nebylo možné aktualizovat. V nastavení je třeba zvolit 

možnost „Lock Original Totals for Comparison“ (obr. 2.45). 

Obrázek 2.45 – Zamknutí „Orig“ sloupce 

Díky této funkci je možné použít rozpočet například pro vytvoření přehledu přijatých 

faktur. Po zamknutí sloupce „Original“ lze přijaté faktury přepisovat do rozpočtu a 

v rozdílu sledovat rezervy ve všech kategoriích.  

2.3.3 Nastavení DPH / Fringes 

Fringes jsou poplatky asociacím a lokacím, na kterých probíhá natáčení. V českých 

podmínkách se tento druh poplatků nevyskytuje. Nástroj Fringes ovšem lze použít pro 
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přidání daně z přidané hodnoty (dále DPH). Standardně se rozpočet sestavuje bez DPH, ale 

v jistých případech se s DPH musí počítat, například při počítání cash flow neboli toku 

financí v průběhu výroby AV díla.  

Nástroj pro správu Fringes lze otevřít v záložce Setup > Fringes. V nástroji lze nastavit 

poplatky plošně, počítané za jednotku (Fringe Benefits by Flat Rate per Unit). Pro potřeby 

nastavení DPH je však potřeba věnovat pozornost první části nástroje, ve které jsou poplatky 

počítány procentuálním podílem (Fringe Benefits by Percentage) (obr. 2.46). Do sloupce 

„Name“ lze umístit název vytvářeného poplatku. V dalším sloupci „Description“ lze uvést 

popis poplatku a do sloupce „ID“ se uvádí zkratka, která se bude zobrazovat v rozpočtu u 

položek, které budou do daného poplatku spadat. Sloupec „%“ umožňuje zadat procentuální 

podíl z položky, na kterou bude poplatek aplikován. Sloupec „Cutoff“ slouží k nastavení 

maximální hranice poplatku. Při vytváření poplatku DPH je tento sloupec zbytečný a lze ho 

ponechat prázdný. Poslední sloupec „Total“ udává celkový součet poplatku ze všech 

položek, na které byl aplikován. 

Obrázek 2.46 – Nástroj Fringes 

Pro umístění poplatku do položek slouží ikona se znakem „F%“, která otevře seznam všech 

vytvořených poplatků. Poplatek se následně přidá označením položek v rozpočtu a kliknutím 

na vybraný poplatek ze seznamu (obr. 2.47). Pro zobrazení informací o přidaných poplatcích 

lze odkrýt dva sloupce na třetí úrovni rozpočtu kliknutím na tlačítka „AGG“ a „FRIN“ 

v horním panelu. První odkrytý sloupec „AggFr%“ ukazuje celkový procentuální podíl 

poplatku z dané položky a sloupec „FRIN“ zobrazuje zkratky (sloupec „ID“ v nastavení 

Fringes) aplikovaných poplatků.  
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Obrázek 2.47 – Aplikace poplatku DPH 

Součet poplatků lze zobrazit pomocí nastavení v nástroji Budget Preferences, který lze 

otevřít v záložce Setup > Budget Preferences. V levé části lze rozbalit nabídka „Post Fringes 

by“ (obr 2.48). Při zvolení výběru „Budget“ se v úvodní vrstvě rozpočtu (Topsheet) zobrazí 

součet poplatků z celého rozpočtu jako samostatný řádek. Při zvolení „Production Level“ se 

součet poplatků zobrazí jako řádek nad každým mezisoučtem v úvodní vrstvě rozpočtu a 

bude sčítat poplatky z položek v daném mezisoučtu. Výběrem „Category“ se vytvoří součet 

poplatků zvlášť v každé kategorii na druhé úrovni rozpočtu. Při výběru možnosti „Account“ 

se bude součet poplatků zobrazovat ve třetí úrovni rozpočtu. 

Obrázek 2.48 – Nastavení zobrazení poplatků 



UTB ve Zlíně, Fakulta multimediálních komunikací 46 
 

Další možností jak zobrazovat poplatky je nastavit zobrazení nového sloupce s informací o 

poplatku na první a druhé úrovni rozpočtu v záložce Data > Show Fringe Total Column. Ve 

sloupci se zobrazuje součet poplatků dané kategorie. 

Výhodou tohoto způsobu počítání DPH je možnost kdykoliv vypnout všechny poplatky 

najednou. V nastavení Fringes stačí do sloupce „Cutoff“ napsat hodnotu 1. Všechny 

poplatky s touto hodnotou přepočítají svůj podíl na 0.00% a nezasahují do verze rozpočtu 

počítaného bez DPH. 

2.3.4 Sub Budget 

Další způsob vytvoření varianty rozpočtu je pomocí funkce Sub Budget. Ta umožňuje 

vytvořit kopii stávajícího rozpočtu bez ovlivnění originální verze. Kopie se vytvoří v záložce 

File > Create Sub Budget. Před vytvořením kopie je možné z nabídky vybrat, zda se do 

vytvořené kopie přenesou i nastavené měny, skupiny a poplatky z původní verze (obr. 2.49). 

 Obrázek 2.49 – Vytvoření Sub Budget 

Kopii lze libovolně upravit, tisknout nebo uložit jako nový rozpočet. Výhodou je, že všechny 

změny provedené v kopii rozpočtu, se nepřenáší do původní verze. 

2.3.5 Porovnání rozpočtů 

V programu MMB lze použít nástroj Budget Comparison k porovnání dvou a více rozpočtů. 

Nástroj umí na základě účetních čísel porovnat rozdíl mezi jednotlivými kategoriemi a 

položkami v porovnávaných rozpočtech anebo umožňuje vybrané rozpočty sečíst.  
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Nástroj lze otevřít v záložce File > Budget Comparison. V otevřeném okně je třeba tlačítkem 

„>>Add“ přidat složky s rozpočtem k porovnání. Je možné zvolit, zda se budou rozpočty 

porovnávat (Variance), sčítat (Average) anebo obojí (Both). Také je možné zvolit, zda se 

bude porovnávat celý rozpočet, pouze hlavní strana (Topsheet) nebo vybraný rozsah položek 

podle účetních čísel (obr. 2.50). 

 Obrázek 2.50 – Vytvoření Budget Comparison 

Při výběru možnosti porovnání se otevře hlavní strana rozpočtu seřazená podle účetních 

čísel. K porovnání slouží 4 sloupce s hodnotami. V prvním a druhém jsou hodnoty 

porovnávaných rozpočtů. V dalším sloupci „Variance“ je rozdíl jednotlivých kategorií a ve 

sloupci „Percent +/-“ je tento rozdíl zaokrouhleně vyjádřen v procentech. Srovnávají se 

nejen kategorie, ale i celkové součty. Pomocí záložky „Accounts“ ve spodní části nástroje 

lze přejít do porovnání jednotlivých účetních položek (obr. 2.51).  

 Obrázek 2.51 – Budget Comparison 
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Při výběru možnosti součtu rozpočtů se otevře stejné okno jako při srovnávání s tím 

rozdílem, že poslední dva sloupce mají jiný účel. První s označením „Total“ sčítá položky 

z obou rozpočtů a druhý sloupec „Average“ zobrazuje průměr všech srovnávaných kategorií 

a položek (obr. 2.52). 

 Obrázek 2.52 – Budget Comparison - součet 

2.3.6 Nastavení exportu 

Export rozpočtu v programu MMB nabízí komplexní nastavení, díky kterému lze mít plnou 

kontrolu nad jakýmkoliv výstupem. Je možné exportovat zvlášť samostatné kategorie, nebo 

pouze jejich určitý rozsah. Je možné nastavit, aby se z rozpočtu vynechaly prázdné řádky 

apod. Zároveň umožňuje do exportů přidat libovolné informace o projektu. 

Nastavení exportu lze otevřít v záložce File > Print Setup. Tlačítko „Page Setup“ v horní 

části otevře možnosti rozložení exportu tzn. přizpůsobení stránky, její velikost, okraje, nebo 

rozložení na výšku či šířku stránky. Tlačítko „Edit Header/Footer“ otevře nabídku, ve které 

je možné vybrat úpravu hlavní stránky rozpočtu (Topsheet Only) nebo dalších podúrovní a 

reportů (Report)(obr. 2.53). 

 Obrázek 2.53 – Print Setup – nastavení hlavní stránky 



UTB ve Zlíně, Fakulta multimediálních komunikací 49 
 

Po otevření úprav hlavní stránky se zobrazí nastavení Topsheet Header, Footer, ve kterém 

je možné přidávat informace o projektu do záhlaví a patičky exportu. Pro přepnutí mezi 

záhlavím (Header) a patičkou (Footer) slouží zaškrtávací políčko v horní části. Nastavení 

umožňuje přidat informace na střed (Center), na levou (Left) nebo pravou (Right) stranu 

stránky. Informace je možné doplnit manuálně nebo lze vložit zkratku, která v konečném 

exportu zobrazí vybraný druh informace. Zkratku lze přidat pomocí rozbalovací nabídky 

vpravo nahoře (obr. 2.53) a na výběr je několik zkratek. „Page#“ vloží automatické číslování 

stránky, „Current Date“ a „Curent Time“ přidá zkratku, která v místě vložení zobrazí 

aktuální datum a čas exportu. „Application Version #“ vloží informaci o verzi programu 

MMB, ve které byl export proveden. „Budget #“ a „Budget Revision #“ vloží informaci o 

číslu rozpočtu a číslu revize z nastavení viz kapitola 2.1.2 Nastavení projektu. „Budget 

Creation Date“ a „Budget File Name“ vloží informaci o datu vytvoření a názvu složky 

s projektem. „Budget Title“ vloží informaci o názvu projektu z nastavení (obr. 2.54). 

 Obrázek 2.54 – Nastavení Topsheet Header 

Stejné nastavení lze učinit i pro další stránky exportu při výběru nastavení Report. 
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Hlavní část nastavení exportu má dvě záložky. V části „Print Selection“ lze nastavit, jaká 

část rozpočtu se bude exportovat. Kromě výběru, zda součástí exportu budou všechny 

úrovně rozpočtu (Details, Topsheet, Accounts), lze i nastavit, aby se exportoval výčet 

jednotlivých skupin, poplatků, měn apod. (Globals Table, Groups Table, Location Table…). 

Rozbalovací nabídka v části „Budget Data Option“ nabízí praktické nastavení toho, zda se 

bude exportovat celý rozpočet (Print All Accounts(s)), nebo zda se z něj vynechají prázdné 

nevyplněné řádky (Suppress Empty Acount(s)), případně zda se vynechají všechny položky, 

jejichž hodnota je 0 (Suppress Zero Total Account(s))(obr. 2.55). Ve spodní části záložky 

lze nastavit rozsah položek podle účetních čísel, které se tak mohou samostatně exportovat. 

 Obrázek 2.55 – Nastavení záložky Print Selection 

V druhé záložce nastavení „Print Settings“ lze pomocí zaškrtávacích políček vybrat, jaké 

sloupce budou do exportu zařazeny. Ve spodní části (Do not truncate the following columns) 

lze vybrat, jaké sloupce se nebudou během exportu přizpůsobovat velikosti stránky. 

Nastavení v dolní části pak umožňuje změnit velikost fondu, umožňuje zalomení textu (Text 

Wrap) nebo barevný tisk (Print In Color). Z rozbalovací nabídky „Page Break“ lze vybrat 

způsob, jakým se budou rozdělovat jednotlivé stránky. Možnost „Per Report“ ukončí stránku 

za každou vrstvou rozpočtu nebo reportem. Výběr „Production Level“ rozdělí export na 

stránky podle mezisoučtu z hlavní strany rozpočtu a výběr „Category“ ukončí stránku po 
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každé kategorii. V každém případě lze vždy obnovit nastavení do defaultní podoby pomocí 

tlačítka „Restore Report“ (obr. 2.56). 

 Obrázek 2.56 – Tlačítko Restore Report 
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3 POROVNÁNÍ  ROZPOČTŮ 

Tato kapitola je věnována srovnání třech forem rozpočtu. První, nejběžněji používanou 

formou, je rozpočet postavený v programu Microsoft Excel. Využívá ji většina nezávislých 

producentů v audiovizi. Druhou formou je rozpočet českého Státního fondu kinematografie, 

který je také postaven v programu Microsoft Excel, ale se zamčenou, fixní strukturou. Dá se 

tedy do tohoto srovnání zapojit jako samostatná forma. Třetí forma rozpočtu je ta, kterou 

používá program Movie Magic Budgeting.  

3.1 Popis zkoumaných rozpočtů 

3.1.1 Excel  

Program Microsoft Excel je tabulkový software, který umožňuje obrovskou volnost při 

budování jakéhokoliv tabulkového produktu. Pro stavbu rozpočtu je to ideální program 

disponující mnoho nástroji sloužící k matematickým propočtům a formátování buněk.  

Samotná struktura rozpočtu je u každého producenta odlišná, protože filmový rozpočet je 

nezbytné v programu Excel vybudovat od začátku a kritéria jeho podoby jsou individuální. 

Dodržují se zásady rozpočtování jako číslování položek, rozdělení do kategorií nebo 

samostatná část se sumarizací hlavních kategorií. K výpočtu jednotlivých položek se 

standardně používá systém jednotek a jejich násobení (cena za den x počet dní). Díky 

možnostem programu může mít rozpočet jednoduchou, stručnou podobu nebo rozsáhlou 

detailně propočítanou a komplexní strukturu. Vždy pak záleží na požadavkách producenta a 

hlavně na podmínkách konkrétního projektu. 

3.1.2 Státní fond kinematografie 

Státní fond kinematografie připravil pro žadatele státních dotací v oblastí vývoje a výroby 

AV díla vlastní verzi rozpočtu sestavenou pomocí programu Microsoft Excel. Struktura je 

uzamčena a jedná se tak o jednotnou formu rozpočtu pro všechny uchazeče a jejich projekty. 

Struktura vychází ze standardů rozpočtování a obsahuje jednu titulní stranu se sumarizací 

hlavních kategorií a druhou stranu s podrobným rozpočtem položek.  

Fixní výčet položek je možné doplňovat pouze o informaci o jednotce a sumě. Fixně je 

nastavený i samotný vzorec pro kalkulaci položek.  

Rozpočet Státního fondu kinematografie tak v konečném důsledku funguje jako formulář, 

který je uživatelem doplňován o částky. 
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3.1.3 Movie Magic Budgeting 

Program Movie Magic Budgeting je placený software specializovaný na stavbu rozpočtu 

audiovizuálního díla a práci s ním.  

Struktura rozpočtu je postavena na systému čtyř vrstev rozpočtu. První slouží k sumarizaci 

hlavních kategorií, druhá vrstva k výčtu účetních položek, třetí vrstva slouží k upřesnění 

jednotlivých položek a čtvrtá vrstva slouží jako prostor pro doplňující informace.  

Kalkulace položek je navázána na nástroje programu, které se upravují podle potřeb daného 

projektu. Nástroje jsou z části nastaveny pro rozpočtování americkým způsobem, je však 

možné jejich užívání uzpůsobit požadavkům rozpočtu v českém prostředí. 

Výstupy rozpočtu v programu MMB je možné do jisté míry upravovat, podrobný rozpočet 

ale vždy podléhá vrstvené struktuře rozpočtu.  

3.2 Rozdíly zkoumaných rozpočtů 

Každá ze zkoumaných forem rozpočtu má své výhody i nevýhody, své zastánce i odpůrce. 

Rozpočet v Excelu může mít díky svým možnostem libovolnou podobu a rozsah 

přizpůsobený potřebám projektu. Možnost formátovat každou buňku umožňuje každý 

rozpočet ušít na míru. Ve světě audiovizuálních rozpočtů neexistuje položka, která by 

v tomto programu nešla zpracovat a vyčíslit. Neomezené prostředí programu navíc 

umožňuje přímo na rozpočet napojit i vyúčtování projektu, cashflow projektu nebo finanční 

plán. Program Excel se v produkčním oddělení běžně používá k práci s rozpisy, výpočty, 

výkazy a dalšími dokumenty vyžadující tabulkový software. To poskytuje výhodu ve 

všeobecné znalosti uživatelského prostředí tohoto programu, Téměř veškerou manipulaci 

s hodnotami a propočty je nutné dělat manuálně a tak nejen, že práce s rozpočtem 

v programu Excel může být velmi pracná, ale je zde nebezpečně veliký prostor pro chybu 

způsobenou lidským faktorem.  

Přesně to má eliminovat forma rozpočtu vytvořená Státním fondem kinematografie. Snaha 

vytvořit rozpočet, který je jednotný pro všechny projekty a není v něm prostor pro selhání 

výpočtu. Výsledkem je však tuhý formát, jehož funkce jsou omezeny na doplnění informací 

a čísel formou běžného formuláře. Každý filmový projekt má své originální potřeby a 

parametry. Výsledkem unifikace rozpočtu u takového odvětví vede k častým kolizím. Pro 

určité projekty tak může být v této formě spousty zbytečných položek, zatímco u jiného 

projektu budou některé položky scházet. Často vede práce s touto formou rozpočtu 
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k nezbytnému slučování vícero položek do jedné, aby vše pasovalo do vytvořené fixní 

formy. Rozepisování položek na jednotky je pak v jistých případech naprostá utopie. 

Výhodou je však jednoznačná přehlednost výsledné podoby. Poslušnému seznamu položek 

porozumí i jiní uživatelé než filmoví profesionálové.  

Forma rozpočtu v Movie Magic Budgetingu je díky své specializaci na filmový rozpočet 

unikátní ve své účelnosti. Obsahuje dostatečnou míru možnosti editace i automatizace. 

Nejedná se však o příliš intuitivní prostředí a pro práci v něm je nezbytná znalost programu, 

jeho funkcí a struktury. Distribuce rozpočtu napříč profesemi, které ho při své práci využívají 

(převážně v produkčním oddělení) může narazit na neznalost programu a práce s ním.  
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4 VÝZKUM 

4.1 Cíl výzkumu 

Cílem výzkumné části této práce je průzkum nezávislých produkčních společností a 

nezávislých producentů, kteří se zabývají výrobou českého hraného filmu, a zmapování 

jejich vztahu k programu Movie Magic Budgeting.  

Hlavní otázkou výzkumu je zjistit, v jaké míře se v oblasti českého hraného filmu používá 

program MMB.  

4.1.1 Stanovení výzkumných otázek 

Výchozí otázky výzkumného šetření: 

• Používáte při práci s filmovým rozpočtem program Movie Magic Budgeting 

(MMB)?  

• Pokud ne, z jakého důvodu: 

a) jsem zvyklý na práci v jiném programu, 

b) licence k programu MMB je příliš drahá, 

c) myslím si, že program MMB není vhodný pro rozpočet českého filmu, 

d) neznám program MMB, 

e) v programu MMB neumím pracovat, 

f) jiný důvod (prosím uveďte jaký). 

4.2 Výzkumné metody 

Pro své šetření jsem vybral kvantitativní metodu dotazníkového šetření. Výsledky jsem 

analyzoval statisticko-matematickou metodou. Sběr dat pomocí dotazníkového šetření 

proběhl pomocí emailové korespondence s respondenty. Podmínka pro selekci respondentů 

byla jejich majoritní participace na výrobě alespoň jednoho hraného českého filmu. Pro 

výběr respondentů jsem použil databázi Asociace producentů v audiovizi a databázi 

produkčních společností Českého filmového centra.  
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4.3 Popis průběhu výzkumu 

Do dotazníkového šetření bylo zahrnuto celkem 90 respondentů splňující kritéria výzkumu. 

Návratnost dotazníku byla 39,6%. Dotazníkové šetření proběhlo v lednu v roce 2020.  

4.4 Odpovědi na výzkumné otázky 

Z 90 dotázaných respondentů se jich průzkumu zúčastnilo 44. Celkem 32% z nich 

odpovědělo kladně na první otázku dotazníku tj. že program MMB při práci s rozpočtem 

používají. 68% respondentů program MMB při své práci nepoužívá z několika důvodů. 

Nejčastější důvod, který respondenti uvedli, je zvyklost práce s rozpočtem v jiném 

programu. Tento důvod uvedlo 34% respondentů. 7% respondentů uvedlo, že program 

MMB neznají. 5% respondentů program MMB nepoužívá, protože si myslí, že není vhodný 

pro rozpočet českého hraného filmu. K těmto lidem se však může připočíst dalších 7% 

respondentů, kteří program nepoužívají z toho důvodu, že Státní fond kinematografie 

vyžaduje jinou formu rozpočtu pro žadatele o finanční dotace. Dalších 9% respondentů 

program MMB nepoužívá, protože ze své pozice producenta hraného filmu s rozpočtem 

nepracuje a najímá k tomu specializovanou profesi. Pouhá 2% respondentů program 

nepoužívá z toho důvodu, že je příliš drahý. Stejné množství respondentů odpovědělo, že 

program MMB nepoužívá, protože v něm neumí pracovat. 

Výsledky dotazníkového šetření jsou zapracovány do grafu (obr. 4.1.).  

Obrázek 4.1 – Graf výsledků dotazníkového šetření 
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ZÁVĚR 

Cílem této práce bylo přiblížení tématu rozpočtu pro hraný film v oblasti české 

kinematografie, definování konvenčních postupů používaných při stavbě rozpočtu a 

vymezení hlavní problematiky.  

Hlavním pilířem této práce je návod na stavbu a manipulaci s rozpočtem hraného filmu 

v českých podmínkách pomocí specializovaného programu Movie Magic Budgeting. 

V samostatných kapitolách jsem popsal jednotlivé funkce a adaptoval možnosti programu 

na podmínky, které se v prostředí české kinematografie vyskytují. Zároveň jsem podrobil 

používání programu MMB komparaci s hlavními formami rozpočtu, které se v oblasti 

českého hraného filmu vyskytují a vymezil jsem jejich výhody a nevýhody.  

Ve výzkumné části této práce jsem pomocí dotazníkového šetření zmapoval používání 

programu MMB nezávislými produkčními společnostmi a producenty působících v oblasti 

hraného filmu v České republice.  

Výsledkem práce je funkční návod pro práci se specializovaným programem pro práci 

s rozpočtem a zjištění v jaké míře jsou producenti v České republice ochotni ho ke své práci 

využívat.  
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SEZNAM POUŽITÝCH SYMBOLŮ A ZKRATEK 

AV  Audiovizuální 

DPH Daň z přidané hodnoty 

MMB Movie Magic Budgeting 

MMS Movie Magic Scheduling 
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